
Class	Maker	2016	

Program Description 

Creating classes for the new school year is a time consuming task that teachers are asked to 

complete each year. Many schools offer their students the opportunity to request friends to 

accompany them into the new year. The task of trying to balance class size with student academic 

ability, behaviour, classroom participation and gender while ensuring that everyone has a friend is 

considerable. 

Class Maker is an innovative software solution, developed to streamline this process and provide a 

number of balanced grade alternatives for teachers to choose from. Class groups can be sorted 

according to the following criteria. 

• Friend Requests 

Students have the opportunity to nominate up to 4 friends who they would like to be with the 

following year.  Class Maker uses advanced matching algorithms to satisfy these requests. The 

program also offers the option to relax these requirements by allowing some friend requests to 

remain unfulfilled. 

• Student Separation 

Class Maker provides teachers the ability to separate students, even if the student has requested 

a particular friend. The teacher’s condition overrides the student’s request. 

• Essential Student Grouping 

There are times when students need to be kept together. Class Maker allows teachers to fix any 

number of student pairs or multiple groups of students into the same class. 

• Multi-age (composite) classes 

Class Maker provides the teacher the ability to create multi-age classes with 2 or 3 different year 

levels, and to control the ratio of each year level in the created classes. 

• Manual Class Size 

By default, Class Maker creates grades of equal or near-equal size. However, it also offers the 

ability to create classes of any size to suit the requirements of the school. 

• Gender Ratio 

It can be important to maintain a mix of male and female students in a particular grade. Class 

Maker provides the teacher the ability to produce class sets with any gender ratio required. 

• Teacher choice (new for 2016) 

A student may need to be placed in a particular teacher’s class, or alternatively there may be a 

request to not be placed with that teacher. Class Maker offers this choice as an option. 

• File Compatibility 

Class Maker provides an easy to use Microsoft Excel template for student data input, which 

includes internal checking to ensure correct spelling of students' names. Class Maker outputs the 

sorted class data in Excel compatible format for easy viewing, manipulation and printing. 



Student	Information	File	Input	

Class Maker uses a familiar Excel file format for entering student information. A template is included 

with the software to help you create your own class sets. It is highly recommended that you use this 

template for your own class lists, as it contains macros and internal checks to ensure the students’ 

names are spelled correctly and that there are no internal inconsistencies. The figure below shows 

the file format with a description of each column. 

  

Column A – Student ID 

Column A is where the students’ names are placed. This should be in Firstname Lastname format, as 

Class Maker will sort the classes alphabetically using the second name specified here. If more than 

two names are specified here, Class Maker will use the first space (as read from the left) to separate 

the first name from the last name. 

Do not use commas in this column to separate student names, or in fact anywhere else in the 

spreadsheet. Some education departments issue student names in “Lastname, Firstname” format. If 

you have your student data in this format, another Excel file which is included in the Class Maker 

2016 package will reformat the student names for you (see the file called “Firstname Lastname swap 

with commas.xlsx”. 

Columns B to C – Student information 

Column B contains the gender of the student, which must be either “M” or “F” (without the 

“quotes”).  Column C contains the student’s current year level. For prep/foundation students you 

can enter the number zero “0”. This column is used for multi-aged (composite) class creation. 

This is also the column where you can identify a teacher by entering the letter “T”. If you want to link 

students with particular teachers to make your classes, you must include the same number of 

teachers in your data file as you have classes (ie 4 teachers for 4 classes). Teachers only need a name 

(eg Mr. A) and the letter “T” placed in column C. 

Columns D to G – Student ability and personality levels 

These optional columns provide additional information about the classes the program makes. When 

Class Maker finds a class set where all the students have friends, it then uses the data in these 

columns to calculate averages for each class. This will help avoid the situation where one class has all 



the high achievers while another is relatively low. It can also avoid having all of the quieter students 

in one class while filling another with students who have poor behaviour.  

A new feature in Class Maker 2016 is the ability to customise columns D to G to suit your own school 

requirements. By changing the text in the appropriate column in row 1 of the spreadsheet, you can 

specify your own identifier. For instance, you may not need the “Participation” column, but may 

instead wish to identify ESL ability levels, or musical ability etc. By changing the text in the column 

header, Class Maker 2016 will use this identifier in its class averages. 

Another new feature in Class Maker 2016 is that five levels of performance are now used instead of 

three. You now enter the ability score as a number from 1 to 5, and Class Maker 2016 will calculate 

an average for the entire class based on these scores, centred about 3. For backwards compatibility 

with previous versions of Class Maker, you can also enter “L”, “M” or “H” in these columns. These 

will be given scores of 1, 3 and 5 respectively. If you do not enter a score in any particular cell, Class 

Maker 2016 will assign a value of 3 to that cell. 

Column H – Essential friend 

This column is used to force students together into a particular class. Enter the student’s name in 

column H to keep the students together, or leave blank. When the program runs, it will only produce 

solutions where these two students are together.  

In the example above, “Samantha Snake” must be in the same class as “Hermione Horse”. Note that 

you do not put Hermione into Samantha’s Essential friend cell. If you need more than two friends 

together, you can “daisy chain” the friends. For instance, if you put, say, Lisa Lemur into Samantha 

Snake’s “Essential Friends” column, the program will only output solutions where all 3 students are 

in the same class.  

When placing students and teachers together, it is preferable to daisy chain any essential students 

into the teacher’s class. For example, typing Lisa Lemur into Mr. A’s Essential friend column, then 

putting Peter Pig in Lisa Lemur’s Essential column will ensure they are both in Mr. A’s class. 

This feature should only be used for those situations where it is absolutely essential, as forcing too 

many students together can significantly reduce the number of solutions available for Class Maker to 

find! It will also significantly increase the time Class Maker will take to find a solution. Best practice is 

to have no more than about 10% of students with an Essential friend specified. 

Columns I to L – Friend requests 

This is where the student friend requests are placed. Up to 4 friends per student can be specified, 

but having less than 4 makes finding a solution far more difficult, especially if there are a lot of 

students in your class list. It will also increase the time taken to find a solution, and in extreme cases 

it may be impossible! If less than 4 friends are requested, please leave the other cells blank or fill 

with “0” (zero). 

For new students, you can leave columns I to L blank. Class Maker will assign their own name into 

Column I, meaning that wherever they are placed they will have a friend (themselves). 



Columns M to N – Incompatible student pairs 

This is where you can force students to be separated from each other in the classes. Names in this 

column override any of the student’s friend requests, and only needs to be in one of the 

incompatible students’ area, not both. Use this option carefully, as forcing too many students apart 

from each other can lead to no solution being able to be found! 

Like specifying Essential friends, this feature should only be used for those situations where it is 

absolutely essential, as forcing too many students apart can significantly reduce the number of 

solutions! It will also significantly increase the time Class Maker will take to find a solution. You 

should have no more than about 20% of students with Incompatible friends specified. If you 

accidently place a student in both the Essential column and the Incompatible column, Class Maker 

will alert you to this fact, otherwise the program will run forever and never come up with a solution! 

The Excel template file 

The Excel template file which comes with Class Maker 2016 will also check for incorrect spelling of 

the students’ names using the “Conditional Formatting” option in Excel. Note the name in Samantha 

Snake’s row (cell I20), where the name “Wrong Spelling” has been entered. This background colour 

of this cell is not coloured green, as the Excel file has been set up to cross-check all the cells 

containing student names against the names entered in Column A – if an exact match is found, the 

cell will turn green, if not the cell will stay white.  

Copying names from one cell to another can break this conditional formatting, but it can be restored 

using a Macro included with the file. Make sure that “Macros” are enabled when opening the file, 

and hit “Ctrl q” to restore the conditional formatting. (“Ctrl q” means hold the “Ctrl” button down, 

then hit the “q” key). When you open the template file you may see the warning message in yellow 

at the top of the spreadsheet which looks something like this. 

 

You must click on the “Enable Content” button to enable the macro. The macro will also remove any 

additional spaces in the student names, whether in front of the first name, behind the second name, 

or even double spaces in between the names. It is good practice to use the macro to check your 

student data file before trying to run Class Maker. 

It will be easier to edit the demonstration file by overwriting the cells with your own student 

information. Once you have updated the file and you are happy with all the spelling, save the file in 

Excel format using your own file name (eg. Grade 2 list 2016.xls). This file will be used to generate 

your new class data. 

  



Running Class Maker 2016 

Once you have created your class database file, start the program. The first time you start the 

program you may need to run in Administrator mode. Right click the program and select “Run as 

Administrator”. The program will check for a valid licence file (ClassMaker-Licence.lic) which needs 

to be in the same folder as the program. If there is a problem with the licence, an error message will 

appear and the program will default to the “demo” version. Contact the developers if you believe 

you have a valid licence file and the program is not recognising it properly. If a valid licence is found, 

the licence holder will appear in the bottom right corner of the main window.  

 

Registration 

If you are upgrading your licence, or the licence file is not found, press the Registration button to 

bring up a box to enter your unique registration code. Paste the code into the box as shown below 

and press OK. 

 

If you have a valid Registration Key already and pressed the Registration button by accident, pressing 

the “Cancel” button will stop the process. 

Menu items 

Action buttons 
Class columns 

Analysis boxes 



Open database file 

To open your class database, click on the “Open database” button. A dialog box will open, showing 

valid Excel database files. Navigate to the directory containing your database file and either double 

click the file, or single click on the file and press “Open”. The program will then check the database 

file for errors. If a student name is miss-spelled or not present, a dialog box will appear providing 

information as to which student has errors in the Excel database file. You will then need to edit the 

database file to make sure the spelling in the file is correct. 

If the Excel database is correctly formatted, the program will perform a quick analysis of the data, 

giving the number of students read and the average gender balance of the group. This will help you 

ensure the database is complete and set limits for the gender balance of the final class sets. 

Sort Parameters menu 

Clicking on the “Sort Parameters” menu item brings up the box shown below. 

 

This area lets you choose the number of classes you want to place the students into. The “Standard” 

version of the program allows up to four classes, the “Extended” version allows up to eight. Click on 

the “Numbers of classes” area and a dialog box will appear, asking you to enter a number. The value 

you enter will now appear in the menu item, and the number of Class columns will change. 

It is also possible to allow the program to produce class sets with students which do not have a 

friend (Friendless students) or allow incompatible student pairings (Incompatible pairs). Entering a 

number other than 0 into these fields will produce these solutions. For particularly difficult class 

groups this option may be helpful to narrow down the options from which you can choose from for 

the final class sets. It’s also useful to increase these numbers to ensure the program is working 

correctly the first time. Once you are happy the program is working, you can reduce these back to 

zero. 

Options menu 

Clicking on the “Options” menu button brings up the box shown below. 

 

Here you can set the class gender ratio, change the number of solutions the program finds, manually 

choose the class size, force a particular student into Class A or make multi-age (composite) classes.  



By default, the program will sort students into friendship groups, regardless of gender. This may lead 

to classes containing all boys or girls (ie 100% gender split). By clicking on the option button, it is 

possible to force the program to only accept a maximum gender split (say 75% of any one gender) in 

every class. However, setting a value too low may mean it is impossible to find a solution (for 

instance, if the gender ratio of the entire group is 75% girls, setting a value less than this would make 

it impossible to find a solution). If you have forgotten the gender ratio of the entire group, pressing 

the “Statistics” menu button will show you. 

The program will continue searching for solutions until it reaches the value shown in the “Find XX 

solutions” area. You can choose a value from 1 to 20 solutions until the program stops by clicking on 

the menu button. 

The “Manually Choose Class Sizes” option allows you to, well, manually choose the class size. First 

tell the program how many classes you require using the “Sort parameters” menu item. Next, press 

the “Manually Choose Class Sizes” button to bring up a series of input boxes into which you enter 

the class size. The class size numbers will then appear in the Class column headings. 

If a particular student (or group of students) needs to be placed in a particular class, then use “Force 

student into Class A” option. This may be used if a particular student needs to be placed in a small 

class size for instance. This option will significantly increase the time taken to find a solution. 

If you need to make multi-age (composite) classes, the program will use the values in column C of 

the student list spreadsheet. You can make classes with 2 or 3 different year levels using Class 

Maker. After you press the “Make Composite classes” button, follow the prompts to set up your 

classes. If you are making classes with two age levels, Class Maker will ask you to set the maximum 

age ratio in each class. In other words, you can set a value of (say) no more than 70% of a particular 

year level in each class.  

For composites containing three age levels, you need to set the age split manually for each class. For 

example, let’s say class A contains 10 year 3’s and 6 year 4’s, while class B contains 6 year 3’s, 6 year 

4’s and 6 year 5’s, and so on. If you make a mistake entering the class numbers (for multi-age 

composites containing three year levels) or the year level ratio (for multi-age classes containing two 

year levels), just hit the “Cancel” button and start again. If you want to try a different class ratio or 

number, simply click on the “Composites” button (which turns the option off), then click on it again 

to restart the process. 

If instead you would like to make (say)three 3 straight Year 3 classes, three straight Year 4 classes 

and a single 3/4 composite, it will be far quicker to make these classes in two separate sorts using 

the “Manually Choose Class Size” option. Set Class A in each year level to have (say) 10 students, and 

Classes B to D to contain 20 students each. You can then manually combine both Class A sets to give 

you the multi-age composite you require. 

The Debug mode shows some more information if Class Maker 2016 is finding it hard to find a 

solution. It will show the average number of friendless students per iteration. You shouldn’t need to 

use this feature unless requested by the developers. 



Make your classes 

Once you are happy with the database and all the options, press the “Make Classes” button. The 

program will start rearranging the student list and place the students into classes. After each 

combination is created, the “Combinations tried” value will increase, each successful combination 

will increase the number next to the “Successful combinations” box. After each successful 

combination, the student lists will appear in the Class columns. 

If you believe you have enough combinations, or you don’t believe the program is working properly, 

pressing the “Stop” button will stop the program searching. You can then change some of the 

parameters and start again, or view the solutions the program has found. If you have specified a 

number of restrictions, the program could take some time to come up with a solution. Particularly 

difficult class sets with a number of essential groups, student placements and incompatible students 

can take up to an hour to find a single solution. (Of course, you can do something else while the 

program runs ☺). If it still can’t find a solution, re-check your student database file to make sure you 

haven’t got a student which you are forcing to both be with and without another student. Relaxing 

the “Number of friendless students” or “Incompatible students” can help here. 

Once the program has found the required number of solutions, the screen will look something like 

the figure below.  This example used the sample Excel file above (after changing the name “Wrong 

Spelling” to something more appropriate). 

 

The sorted classes are shown in the Class Columns areas. Note the Class Column titles show the 

number of students in each column. The names are sorted alphabetically according to surname. The 

values in the Analysis Boxes at the bottom show the gender ratio, the average numeracy, literacy, 

behaviour and participation scores, as well as the number of friendless students and unsuitable 

matches. The average scores are calculated from the data in columns D to G in the student data file. 



A score of 3 represents a good mixture of student abilities. Values above 4 or below 2 are 

significantly different from the “average”. Of course, the averages will be affected by the overall 

ability scores of the entire group. To find out what the overall averages are, you can press the 

“Statistics” menu item button. For this data set, the statistics are shown below. Note the average 

values for the entire class set are all reasonably close to 3. 

 

The class set shown when the program finished sorting is the last successful combination found, in 

this case combination 10. You can look at other class sets by pressing the up and down arrows next 

to “Show class set #” button. The Class Columns and Analysis Boxes will update accordingly. 

For this sort, the multi-age option was set to “Off”, so the “Multi-age split” row is not applicable for 

this data. If we switch this value on to make multi-age composites with 2 age groups and a maximum 

age level of 75%, Class Maker will re-sort the classes and display new classes with the lowest year 

level ratio shown as a percentage of the class (see below). 

 

 

 

 



For multi-age classes containing 3 age levels, the row displays the actual class numbers (in this case 

years 3/4/5). 

 

If you purchased the “Extended” version of Class Maker, you will also see the “Show Class E – H” 

button on the screen. Unsurprisingly, pressing this button will show classes 5 to 8 (if you requested 

them). They will display on the same screen with updated labels and statistics.  

A new feature in Class Maker 2016 is the inclusion of a “Sorting Efficiency” graph. This gives the user 

some real time feedback on how the sorting process is going. The value shown in the graph is related 

to the number of Essential and Incompatible students present in the data file. The higher the levels 

of both types, the lower the sorting efficiency will be and the longer Class Maker will take to find the 

required number of solutions. You should try to keep the number of Essential and Incompatible 

students below around 10% and 20% of the total student numbers respectively, especially if your 

student numbers are above 100. If you have inadvertently linked a student as “Essential” to one 

student, who is incompatible with a second, who happens to be also essential to the first, the sorting 

efficiency will show as 0% and after a time Class Maker will alert you to this fact and ask you to check 

your data file.  

If the sorting efficiency is high and Class Maker is still not finding any solutions, it may indicate that 

there are a large number of students who do not have 4 friends specified. You should try to give 

every student a choice of 4 friends if possible. You could also try increasing the number of 

“Friendless” students in the Sort Parameters menu and tweak manually. 

  



Tweaking Class Sets 

Class Maker is designed to give you class sets which match your specific criteria, however it also 

allows you to alter the solutions it finds so you can fine tune your classes. If you find a solution using 

the up and down arrows which is almost what you want, but you think there may be a better 

solution, pressing the “Tweak Classes” button will bring up the current class set in a new window 

shown below. Note that all the students’ names are shown in black (this is a valid class set) and that 

the statistics are all shown under the class lists for the 2 age composite shown earlier. 

 

The class lists can be changed using a familiar “Drag and Drop” technique. Simply click on the 

student you wish to move, drag them across the page, and drop them onto the class you would like 

to place them in. The class statistics will instantly update, as will the colours of the students’ names. 

If you placed the student in a class where they no longer have a friend, their name will turn red 

(friendless student). If you put them in a class where they have an incompatible student pairing, that 

name will turn blue. If they have both their name will turn pink, and if any student had an “Essential” 

pairing which is no longer met, their name will turn orange. An example of this is shown below. 

 

 



 

If you decide you would like to save the new “tweaked” class list, simply press the “Save Lists” 

button to save the data to file. Alternatively, you might like to print the data out so pressing the 

“Print” button will print out a low resolution copy of the page for later use. If you decide you’ve 

made too many changes and it’s too hard to go back manually, the “Re-start” button will let you 

start again. Pressing “Cancel” will bring you back to main page. Note that any changes you make 

here will not change the class lists stored in the main page, so you must remember to save or print 

any of your tweaked data sets. 

If you have more than 4 classes, the “Tweak Classes” window will expand to show all the classes, so 

that you can move any student to any class.  

  



Saving Class Sets 

While it might be nice to view the class sets in the program, in order to be useful you need to be able 

to save the data to file. Class Maker offers two options for this purpose, the full sorted class sets 

with all the data you entered, or a summary file giving just the student names and the averages. 

Class Maker outputs the class sets in .csv (comma separated variable) format which can be opened 

in Excel. Use the “File” menu button to bring up the menu items shown below. 

 

Pressing the button for the data type you require (Summary or Full) brings up a box where you can 

type in the filename and directory for your sorted class sets. After the file is saved, double clicking 

the file in Explorer will open Excel and the data file. The Summary data file looks like the figure 

below, where the widths of columns A, B and C have been increased to view the entire student 

names. 

 

• Line 1 gives description of the type of data and the filename used (“Demo Class list 2 year 

composite”), the number of solutions found (10) and the number of classes in each (3). 

• Line 2 shows the class set number (1), and a summary of friendless student numbers. 

• Lines 3 to 5 show the averages for each class, which you can use to choose the best set from 

the options available. 

• Lines 6 to 13 show the class lists. You can copy and paste these cells to any other program 

you like, eg into a table in Word, or keep the data in Excel format. 

• Line 14 is a line space used to separate different class sets from each other. 

• Line 15 is the same as line 2, only for class set 2. The cycle then repeats for all class sets. 

  



If you would like to see all the data (for example if you want to check the program is actually working 

correctly or you want to double check the data), you can output the entire data set by pressing the 

“Save full data file” button. This again outputs the data in .csv format, and looks like this. 

 

This data file is more difficult to use as class sets, but if you want to see the full data file for checking 

purposes (or don’t trust the program is working correctly ☺ ), you can use this file format.  

Importing Class Sets 

Class Maker also allows you to import previously saved Summary and Tweaked data files so you can 

view the class lists or tweak them a little more. To do this, perform the following steps:  

 

1. Open the student database file (the Excel file, not the saved class set file) as if you were 

going to make a new class set  

2. Press “File/Import Saved Data” from the “File” menu  

3. Click and open the saved class data file, this must be in csv format, not an Excel file  

 

You should now be able to tweak the saved class lists as before. 

 

In order to be able to import these data files for re-tweaking, it is important that the files are not 

changed in any way. Class Maker requires the files be in exactly the format it wrote them in, and if 

they are edited it will not be able to read them back again. If you do want to save a copy of the 

Summary or Tweaked data files, please make a copy and save them using a different file name 

and/or format. 

  



Final thoughts 

Hopefully this guide has helped you create your own sorted class lists. If not, or if you have any 

suggestions, bug fixes or improvements you would like to see, please contact the developers of the 

program and we’ll see if we can help solve your problems. The school we used as a test platform 

suggested many of the options available in the program, if there is a specific problem you would like 

to see incorporated in future versions, please let us know. 

When there are a large number of students in a class set, Class Maker can take a long time to find a 

valid solution. To understand why, consider that the total number of unique class sets that can be 

made by placing 100 students into 4 classes is 
���!

��!��!��!��!�!
 , which in numerical terms is 6.71753 x 

10
55

 (or  67,175,312,842,324,100,000,000,000,000,000,000,000,000,000,000,000,000,000) possible 

different combinations! (Sorting 150 students into 6 classes gives 5.6975 x 10
108

 possible 

combinations). It therefore may be helpful to start the program allowing a few Friendless students 

and Incompatible pairings to help Class Maker reduce this total number to manageable levels.  

If you have found the program useful, please tell your friends and colleagues about your experience!  

Thanks. 

Andrew  

AA Educational Software  

http://classmaker1.wix.com/classmaker 

 


